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Schedule Triggers 

Schedule triggers are a powerful tool that allows you to schedule actions for automatic 

execution, such as sending an email to an employee or someone outside the company, 

assigning a task and sending a message or an alarm. Actions can be scheduled using a range 

of frequencies along with a start date. 

Schedule triggers are based on specified points in time. When the time is met (and the trigger 

has not already been executed on that date), the trigger is executed and its associated actions 

are taken. Schedule triggers are tested to see if their conditions are met when logging into 

People-Trak, switching between modules and executing NightRun.  

The Schedule Trigger screen provides a list of the schedule triggers on the left and a data 

entry area to the right. A Menu Bar and a Tool Bar are provided to enable you to fully 

manage your list of schedule triggers. The Schedule Triggers process uses a three-tabbed 

screen as described below. 

Details Tab 

The Details tab is used to name the trigger, assign it to a category, and define the Last and 

Next Execution dates. 

Last Execution  
The date the schedule trigger was last executed. This date is updated to the current date by the 

system whenever the trigger is executed and is for display only. 

Next Execution  
The date the schedule trigger will next execute. This date is updated by the system whenever 

the trigger is executed and is based on the value in the Frequency field. For example, if the 

Last Execution date is 7-31-09 and the Frequency is Monthly, the Next Execution date would 

be 8-31-09, one month later. 

Note: If you change the conditions under which a schedule trigger is executed, you will need 

to clear the Next Execution field if it has a date in it. The next execution will then be done 

according to your new conditions. 

Conditions Tab 

The Conditions tab is used to define the conditions by which the schedule trigger will be 

executesd such as frequency and starting date. 

Frequency 
 The frequency that the schedule trigger will be executed. 

Daily: The trigger will be executed each day. If you set the Start Date field many days in 

advance, the trigger will not execute until that day. 

Weekly: The trigger will be executed each week on the weekday that matches the Start Date 

field. 
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Monthly: The trigger will be executed each month on the day of the month that matches the 

day of the Start Date. 

Quarterly: The trigger will be executed every three months on the day of the month that 

matches the day of the Start Date. 

Annually: The trigger will be executed each year on the day of the year indicated by the 

month and day of the Start Date.  

One Time Only: The trigger will be executed just once on the day specified by the Start Date 

field. After the trigger is executed, the Active check box is deselected to ensure the trigger is 

not executed again. 

Every So Many Days: The trigger will be executed every “N” days beginning on the day 

specified by the Start Date field. The number of days “N” is specified in the Number of Days 

field. 

Start Date  
The start date of the schedule trigger. 

Day of Week/ Day of Month/ Number of Days  
There will sometimes be a third field in the Conditions frame depending on the Frequency 

chosen. If the Frequency is Weekly, the Day of Week field displays the day of the week on 

which the schedule trigger will be executed. If the Frequency is Monthly, the Day of Month 

field displays the day of the month on which the schedule trigger will be executed. If the 

Frequency is Every So Many Days, the Number of Days field allows you to enter the number 

of days between schedule trigger activation. 

Note: If you set the Frequency to Monthly and the Day of Month is 28 or higher, People-Trak 

assumes that you want to run the report at the end of every month. This is required in the 

event that you have a Start Date of March 31 because not all months have 31 days. 

Action Tab 

The Actions tab is used to specify the actions to be taken when the schedule trigger 

conditions have been met. There can be more than one action to take, and the actions are 

executed in the order they are listed here. The following are the action types allowed for a 

schedule trigger. 

 Assign Task 

 Send Email 

 Send Message 

 Set Alarm 

 

Assign Task 
The Assign Task action assigns a task to any user, including yourself. There are eight 

different types of tasks: activity, administration, create, document, edit, link, processing and 

table. Once the trigger takes effect, the selected task will be sent to the specified user’s Inbox. 

From the Inbox, the user can execute that task, which will run an activity, launch an 

administrative action, create a new record, run a document, edit records, access a link , run a 

process, or maintain a table. 
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Send Email 
The Send Email action sends an email to the specified recipients. When you select this action, 

the following screen is displayed. This is the standard Send Email screen used throughout 

People-Trak.  

Send Message 
The Send Message action sends a message to the specified user’s Inbox.  

Set Alarm 
The Set Alarm action sets an alarm for yourself or another user for a specified date and time. 

It functions just like using the Set Alarm tool. 

For each action, the Detail:row button allows you to enter the detail for the action. When you 

click the button, a screen unique to that action is displayed for detail to then be entered. 

Alert Triggers 

An alert trigger is the tool best used to remind multiple users of significant upcoming or 

passed dates, or have them perform some action before or after that date. It allows you to 

send an email to an employee or someone outside the company, assign a task, send a message 

or set an alarm. 

Just like schedule triggers, alert triggers are executed when the date is reached, but unlike the 

scheduler trigger, dates are not set by a calendar but by a formula consisting of date fields. 

Any date-oriented field, such as Exam Date, Birth Date, or Hire Date, may be used as the 

chief variable in this formula. Once you have selected this chief variable, you may decide on 

the amount of time before or after this variable, that the alert will take effect. 

This formula is very different from the scheduler trigger because instead of merely executing 

the trigger on the selected date, alert triggers check every day to see if any record’s fields 

meet the criteria defined in the alert trigger. Alert triggers are checked when logging into 

People-Trak, switching between modules and executing NightRun. If a record (or records) 

matches the criteria (and the trigger has not already been executed on that date), the alert 

trigger is executed and its associated actions are taken. 

The Alert Triggers screen provides a list of the current alerts on the left and a data entry area 

to the right. A Menu Bar and a Tool Bar are provided to enable you to fully manage your list 

of alert triggers. The Alert triggers process uses a three-tabbed screen as described below. 

Details Tab 

The Details tab is used to name the trigger, assign it to a category, and define the Last 

Execution date. 

Last Execution 

 The date the alert trigger was last executed. This date determines when the alert trigger will 

next execute. For example, if this date is today’s date, the alert trigger will be checked 

tomorrow. If this date is yesterday’s date, the alert trigger will be checked today. 

Conditions Tab 

The Conditions tab is used to define the conditions by which the alert trigger will be 

executed. The If Today’s Date Is field is composed of four separate fields that make up the 
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alert trigger formula: amount, period, operator, and date. The bottom part of the tab uses the 

standard query grid. 

Amount 

The amount field is used to define how many days, months or years will be used in the 

equation.  

Period 

The period field contains three options: Days, Months or Years. 

Operator 

The operator field allows you to set when the trigger will execute: Before, After, Before 

Anniversary of and After Anniversary of. The Before/After variable will execute sometime 

before/after the field variable. The Before Anniversary of/After Anniversary of variable will 

execute sometime before/after the anniversary of the field variable every year.  

Date 

The date field is the fourth field in the Conditions formula. This field determines what date 

field will be checked in every record. You may track any date field in People-Trak, such as 

Birth Date, Next Exam Date, Hire Date, and Seniority Date. 

In addition to the date field that is being checked, you can add further conditions using the 

standard query grid.  

Addtionally,the Active Records Only checkbox  allows you to specify whether or not you 

want only active records to be included in the alert trigger. Select the check box to only 

include active records in the alert trigger. Clear the check box to include all records in the 

alert trigger. 

Actions Tab 

The Actions tab is used to specify the actions to be taken when the alert trigger conditions 

have been met. There can be more than one action to take, and the actions are executed in the 

order they are listed here. The following are the action types allowed for an alert trigger. 

 Assign Task 

 Send Email 

 Send Message 

 Set Alarm 

 

Assign Task 
The Assign Task action assigns a task to any user, including yourself. There are eight 

different types of tasks: activity, administration, create, document, edit, link, processing and 

table. Once the trigger takes effect, the selected task will be sent to the specified user’s Inbox. 

From the Inbox, the user can execute that task, which will run an activity, launch an 

administrative action, create a new record, run a document, edit records, access a link , run a 

process, or maintain a table. 

Send Email 
The Send Email action sends an email to the specified recipients. When you select this action, 

the following screen is displayed. This is the standard Send Email screen used throughout 

People-Trak.  
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Send Message 
The Send Message action sends a message to the specified user’s Inbox.  

Set Alarm 
The Set Alarm action sets an alarm for yourself or another user for a specified date and time. 

It functions just like using the Set Alarm tool. 

For each action, the Detail:row button allows you to enter the detail for the action. When you 

click the button, a screen unique to that action is displayed for detail to then be entered.  

Activating and Deactivating Triggers 

 For both schedule and alert triggers, there is an Active check box that allows you to specify 

whether or not the schedule trigger is active. Select the check box to make the trigger active 

or clear the check box to make the trigger inactive. When creating a trigger, this check box 

defaults to selected. 

Alarms 

People-Trak provides an internal alarm system. You can manually set alarms for yourself or 

another user for any future date and time using the Set Alarm option on the Tools menu. 

When an alarm time is reached, the alarm text is automatically displayed. If you are not in 

People-Trak when the alarm is activated, it will be displayed upon your next login. 

The alarm will appear in the Inbox of the specified user on the date for which the alarm is set. 

The user can then view the alarm before the alarm is actually activated. 

The Set Alarm screen is used to define the who, when and what settings for the alarm. 

This includes the  User ID of the person for whom the alarm will be set. This field is 

automatically set to the currently logged-in user. 

Additional details to be defined are the date,  time, and  text of the alarm.  

Alarm Frequency 

The alarm engine in People-Trak checks the status of alarms every so many minutes. It is not 

meant to be precise, so you should not set crucial appointments by the system. Each user can 

set the frequency with which alarms are checked. You can check and set this interval using 

the User Setup option on the Setup menu. 

The Alarm Frequency field defines how often alarms are checked for this user. This value is 

normally set to 5 so that alarms are checked every five minutes. Use the popup button to 

display the other alarm frequencies. If you do not want alarms popping up all the time, either 

do not set them, ask other users not to set them for your user name, or increase your interval 

to 60 minutes. 

The Alarm Frequency setting also controls how often the Inbox counter is refreshed. This 

counter shows how many items you have in your Inbox and is displayed below the Inbox icon 

on the Organizer Shortcut Bar. If the Alarm Frequency is set to 5 minutes, the Inbox counter 

will be updated every 5 minutes with the current number of items in your Inbox.  
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Alarm Notification 

When you receive an alarm, it will look similar to the following, with the appropriate field 

values displayed. 

 

Inbox 

The Inbox is easily accessible by using an Inbox shortcut on the Shortcut Bar. Below the 

Inbox icon on the Organizer Shortcut Bar, there is a counter that indicates how many items 

are currently in your Inbox. This counter is refreshed at the same frequency as the Alarm 

Frequency set in User Setup. The counter is also immediately refreshed when switching 

modules.   

The Inbox is your centralized location to display messages and alarms as well as run tasks. 

Items that have effective dates will only show up in the Inbox once that date arrives.  

Running a Scheduled Item 
Scheduled items can be run from the Inbox at any time. The result is different for each 

scheduled item type. 

Running a Process 
If you run a process, the process is started just as if you selected the process from its 

corresponding menu. When the process is completed, you will be returned to the Inbox. The 

Status will be changed to “Completed”.  

Running a Document 
If you run a document, the document is generated just as if you selected the document from 

the Explorer. When the document has been generated, it is displayed within the Document 

Viewer. When you exit the Document Viewer, you will be returned to the Inbox. The Status 

will be changed to “Completed”.  

Showing Alarms 
An alarm will appear in the Inbox of the specified user on the date for which the alarm is set. 

The user can either view the alarm before the alarm is actually activated or wait for the alarm 

to be activated at the specified time.  

When you have reviewed the alarm and click the OK button, you will be returned to the 

Inbox. The Status will be changed to “Read”.   
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Postponing a Scheduled Item 
Items that appear in the schedule need not be run immediately. They can be left in the Inbox 

for days, if you choose. If the item does not need immediate action, you can postpone the 

item until another day.  

When you return from the Select Date popup, the Effective Date column for the item will 

reflect the postponed date and the status will state “Postponed”. If you exit the Inbox and 

return, the item will not be listed because it is not effective for the current day.  

Showing Your Tasks or All Tasks 
If you have been granted access to all items, you can change the list of items between your 

personal list and the list for users using the My Inbox/Full Inbox button. If you have been 

limited to your own items, this button will not appear at all. This feature is very useful in 

multi-user environments to make certain that alerts are reviewed and scheduled items are 

performed. For example, if items are tightly scheduled within an organization and a particular 

user is absent or does not access the Inbox for a few days, the items in the Inbox would not 

normally be run. However, if at least one user is able to see all of the items in the Inbox, that 

user can ensure that items for other users are executed in a timely manner. 

Note: This feature is only available for HR users. 

Granting Access to All Items 
To grant access to all Items, the Show All Users in the Inbox check box on the General would 

be selected if the user can see all items in the Inbox or cleared if the user can only see his or 

her items. 
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Notes 
 

  



  

 

 
Lesson 1 

Alert Triggers and Alarms 
 
 

Lesson Contents 

Tutorial 1.1 – Setting Alert Conditions 10 
Tutorial 1.2 – Sending Email 12 
Tutorial 1.3 – Using Alarms 17 

 

 
This lesson covers how to create an alert trigger, define the conditions under which the alert 

trigger will be executed, and specify the actions to occur when those conditions are met. It 

also covers how to create an alarm. 

Tutorials 
Setting Alert Conditions: shows how to create an alert trigger and define the conditions 

under which the alert will be executed. 

Sending Email: demonstrates how to use the Send Email action for the alert trigger. 

Using Alarms: demonstrates how to create an alarm for specific user, date and time.  
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Tutorial 1.1 – Setting Alert Conditions 

Alert triggers are used to notify people of events that are approaching or have passed based 

on any date within a People-Trak module.  

1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop 

(or as instructed).  

 

The Select Product Option screen is displayed.  

1. The Position Control and Attendance options should be the only options that are 

toggled on. If not select the Training button to select them. 

2. Click OK 

 

The Login screen is displayed. 

3. In the User ID field, enter DEMO. 

4. In the Password field, enter DEMO. 

 

The Organizer desktop is displayed with the Personnel Management module selected.  

5. On the Tools menu, select Alert Triggers. 

 

The Alert Triggers screen is displayed. The Alert Triggers screen uses three tabs to 

specify the details, conditions, and actions of each of your alert triggers. A list of the 

current alert triggers, a Menu Bar, and a Tool Bar are provided to enable you to fully 

manage your alert triggers. Let’s get started and create an alert trigger. 

6. On the File menu, select New Alert Trigger or on the Tool Bar, click the New Alert 

Trigger button to start a new alert trigger.  

 

A default name is assigned. The name is NEW-#, where “#” is the next available, unused 

number. 

7. Change the name of the trigger to Birth Date Alert.  

8. For the Category field, select Personal. 

 

The next field in the Details section is the Active check box. This check box is 

automatically selected when the trigger is first created. It means that this trigger will be 

checked each day. If at some point you wish to deactivate the trigger without deleting it, 

you can simply clear this check box. This is normally done when a trigger that has been 

in production is being changed. While a trigger is being changed and tested, you may not 

want the partially completed trigger to be executed. To prevent this, deactivate the trigger 

while the trigger is being updated and reactivate the trigger when you are ready to test it 

and use it. 

9. Keep the Active check box selected. 

 

For alert triggers, the next field, Last Execution, is very important. When an alert trigger 

is initially created, this date determines when the trigger will next execute. For example, 

if you set the trigger to today, it will indicate that the trigger should first be checked 

tomorrow. If you set the date to yesterday, the trigger will be checked today. Since we 
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want to test our trigger, we either need to set the date to yesterday or leave it blank. We’ll 

set the date to yesterday for our demonstration. 

10. In the Last Execution field, enter yesterday’s date. 

11. Click the Conditions tab. 

 

Alert trigger conditions place a date from a record in an equation. For example, you 

might wish to determine if today is five days prior to an employee’s birth date. Or, you 

might wish to determine if today is ten days since an employee was hired. The condition 

is made up of four fields: the amount, the type of period (days, months, and years), the 

operator, and the field to compare. We’ll build the birth date alert indicated above. 

12. In the If Today’s Date Is field, set the amount field to 5. Set the period type to Days.  

 

Now the operator is powerful, but a little tricky. Pay attention to this. We wish to 

determine if today is five days prior to the employee’s birth date. So, you might decide to 

use the Before operator. However, the employee’s birth date was between 20 and 50 

years ago. Today cannot be prior to the birth date unless the employee has not yet been 

born. You need to use the Before anniversary of operator that compares today’s date to 

the employee’s birth date in the current year. If you wanted to specify an alert for just 

after an employee’s birth date, you would use After anniversary of. Otherwise, you would 

be specifying an enormous number that would only be relevant to an employee born in 

the specific year in which you made the calculation for the number of days. 

13. Select the Before anniversary of operator. Now, in the fourth field, select the Birth Date 

field. The condition should now read as follows:  

 

If Today’s Date is 5 Days 

                Before anniversary of 

                     Birth Date  

 

Before creating an action, we need to address another condition field. This is the Active 

Records Only check box. This field is important because you will normally keep inactive 

records in your company. For most triggers, you will not wish to be notified or take an 

action for an inactive record. In this birth date trigger, we are going to send an email 

reminder to the employees that one of the company holidays is their birthday. This is not 

an action that is relevant for a terminated, retired, or otherwise inactive employee.  

14. Select the Active Records Only check box to limit this alert to active records only. 

 

You can also use the standard query grid to add further conditions. We won’t be using the 

query grid in our example. 

15. Continue with the next tutorial  
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Tutorial 1.2 – Sending Email 

Now that you have the conditions of the alert trigger defined, you are ready to specify the 

actions that are to occur when those conditions are met. 

1. On the Actions tab, click the popup button to display a list of the available actions.  

 

You will see the list of actions available. 

 

Alert triggers do not run when a record is open or when data entry is occurring. In fact, 

alert triggers can run at night when no one is actually logged in to People-Trak. So, 

actions that imply or require user interaction are not listed. You cannot display a screen 

or message.  

 

In our birth date example, we are going to send an email to the employees with upcoming 

birthdays and also an email to their supervisors. 

2. Select the Send Email action. 

3. When you selected the Send Email action, the cursor moved to the second row. Click 

back in the first row and then click the Detail: 1 button to see the detail screen for this 

action. 

 

The Send Email screen is displayed. This screen is the same as the one that you have used 

before when sending email. We want to use a template for our email, so let’s go create 

that right now and then come back here and use it. 

4. Close the Send Email screen, and close the Alert Triggers screen. 

 

You were not asked to save your changes because when you went into details for the 

action, the trigger was saved at that time.  

5. On the Templates menu, select Email Templates. 

6. On the File menu, select New Template or on the Tool Bar, click the New Template 

button. Name the template Birthday Email for Employee. 

7. For the Category field, select Personal. 

8. On the Tool Bar, click the Edit Email Template button and enter the following text:  

 

You will be celebrating a birthday in the next week or so. This is a reminder of company 

policy that each employee receives his or her birthday as one of the assigned paid 

holidays. Enjoy your birthday and enjoy your day off. 

 

If your birthday falls on a weekend, you have your choice of taking either Monday or 

Friday. You will need to notify your manager: ~F~ (insert Supervisor Name) of your 

decision prior to taking the day off. 

9. Close the Email Template Editor, saving your changes.  

10. Create another email template and name the template Birthday Email for Manager, 

placing it in the Personal category as well. 
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11. Edit the template and enter the following text:  

 

Employee: ~F~ (insert Full Name), ID Number: ~F~ (insert Employee ID) has a 

birthday this week. Please be aware that the employee will be taking his or her 

birthday off. If the birthday falls on a weekend, the employee can choose either 

Monday or Friday. It is up to the employee to meet with you to determine which day 

works best. 

 

Thank you, 

 

~F~ (insert User Name from the System category) 

12. Close the Email Template Editor, saving your changes. Close the Email Templates 

screen, saving your changes.  

 

The emails we are going to send are very similar. We could create an email definition for 

one and then copy that. Let’s do that. 

13. On the Administration menu, select Email Definitions. 

14. On the File menu, select New Email Definition or on the Tool Bar, click the New Email 

Definition button. 

 

The new email definition is created.  

15. In the Definition Code field, enter Birthday Notification - Employee. 

 

We would like this email to always come from the Human Resources Generalist, like the 

email definition you created in an earlier lesson.  

16. In the From Address Type field, select Position. 

17. In the From field, click the popup button. 

 

The Lookup Position screen is displayed. 

18. Click Search. 

19. Select 1043 - Human Resources Generalist. 

20. In the Subject field, enter Birthday Notification. 

21. In the Template field, use the popup and select Birthday Email for Employee. 

 

We won’t add any attachments. 

22. On the Tool Bar, click the Save button. 

 

Let’s copy this definition as a shortcut to creating the definition for the manager.  

23. On the File menu, select Copy Email Definition. 

 

A new email definition is created as a copy of the original. 

24. Change the Definition Code to be Birthday Notification - Manager. 
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25. In the Template field, use the popup and select Birthday Email for Manager. 

 

Done! 

26. Close the Email Definitions screen, saving your changes. 

 

Now we are ready to use these email definitions in the alert trigger we already created. 

27. On the Tools menu, select Alert Triggers and then select the Birth Date Alert we have 

been working on.  

28. On the Actions tab, open the details for the Send Email action.  

 

We need to specify to whom to send the email.  

29. In the To Address Type field, click the popup button. 

 

As you learned earlier, the address type fields have several options. Using the Address 

Book would allow you to send this email to the same person all the time. You might want 

this if you have an employee designated as the “birthday guru”, but what if you want the 

email to go to the employee or the employee’s supervisor? In this case, you need to select 

the Field Substitution option. 

 

In our example, we want to send the email to the employee who is about to celebrate a 

birthday, so we need to use Field Substitution. 

30. Select Field Substitution. 

31. In the To field, click the popup button to display a list of the email address fields in the 

Personnel Management module (essentially within the employee record). 

 

There are several email fields available: one for each of the emergency contacts, one for 

the employee, one for the employee supervisor in addition to others. 

32. Select Email, which is the email address field for the employee. 

 

When the alert trigger is executed, it will check each employee for a coming birthday. If 

an employee does have a birthday (anniversary of the birth date) five days from now, that 

employee will receive an email. If there are multiple employees with birthdays, each 

employee will receive their own email message. Contrast this with what would happen if 

you had placed a single employee email address in the To field. That specified employee 

would have received all of the notifications, and that is not what we want, at least for this 

particular trigger.  

33. Click the Message tab. 

34. In the Email Definition field, use the popup to select Birthday Notification - 

Employee. 

 

All of the fields are defaulted accordingly. 

35. Click the Attachments tab. 

 

If we had attached a document to our email definition, it would display in the Attach 

Document field as you learned in earlier training. You also learned that there were three 
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options available for Group Type: Current Group, Current Record and Use Query. When 

sending email from triggers, these options are more limited. For Alert Triggers, you have 

a choice of Current Record or Use Query; Current Group is not an option because there is 

no group available. For Schedule Triggers, you only have a choice of Use Query because 

no records are opened for that type of trigger. 

36. Close the Send Email screen, saving your changes. 

 

Now we’ll add a second email so that we can also notify the employee’s manager. 

37. In the second action row, add a Send Email action, click back in that second row and 

complete the details for it as follows: 

 

To Address Type Field Substitution 

To   Supervisor Email 

Email Definition Birthday Notification - Manager 

38. Close the Send Email screen, saving your changes. Close the Alert Triggers screen. 

 

In order for us to see our trigger work, we need to have some employees that have 

birthdays five days from now. Let’s update two employees to have those dates. 

39. Open Donald Stern’s record and set the month and day of his Birth Date to the 

appropriate month and day five days from now. (For example, if today is February 1, set 

Donald’s birth date to February 6.) Close Donald’s record, saving your changes. 

40. Repeat the above step for Julie Carrington. 

 

Alert triggers are checked when logging into People-Trak, switching between modules or 

executing NightRun. The first time the alert is checked each day, the Last Execution field 

is set to the current date and that alert will not be executed again on that date. When we 

created our sample alert, we set the Last Execution field to yesterday. So, it will run the 

next time we log into People-Trak or change modules.  

41. Switch to the Safety Management module. Any alert triggers in the Safety 

Management module will be checked. Now switch back to the Personnel Management 

module.  

 

The trigger will be executed. The first group of emails are for the employees selected by 

the trigger. You should see Donald and Julie as the recipients (and anyone else who 

happened to be so lucky). The second group of emails are for the managers of those 

employees. 

42. Now, return to the Alert Triggers process and select the Birth Date Alert trigger we 

have been working on. Note that the Last Execution field has been set to today’s date. 

Close the Alert Triggers screen. 

43. Now switch to the Safety Management module and back to the Personnel Management 

module again. Note that the trigger is not executed this time. 

 

Alert triggers can also assign tasks as well as set alarms and send messages.  We will take 

a look at those actions when learning about schedule triggers in the next lesson. For now, 

we will go on to the next tutorial, which will give you an understanding of how to set 

alarms manually, without triggers. 
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44. Continue with the next tutorial.  
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Tutorial 1.3 – Using Alarms 

People-Trak provides a nifty internal alarm system. You can manually set alarms for yourself 

or for another user for any future date and time using the Set Alarm option on the Tools 

menu. When an alarm time is reached, the alarm text is automatically displayed. If you are 

not in People-Trak when the alarm is executed, it will be displayed upon your next login. 

1. On the Tools menu, select Set Alarm.  

 

The Set Alarm screen is displayed. The cursor is positioned in the User ID field. The 

User ID field is automatically set to the currently logged-in user (DEMO) and the Alarm 

Date is set to the current date. 

 

You can actually set an alarm for any user. 

2. In the User ID field, click the popup button to display a list of the available users. We’ll 

keep DEMO (that’s you) so that we can test the alarm quite readily. 

3. You can specify any date in the Alarm Date field, but since we wish to test this alarm 

today, leave the date set to today. 

 

You can specify any time in the Alarm Time field, but since we wish to test this alarm 

shortly, let’s set the time to a few minutes from now.  

4. In the Alarm Time field, click the popup button to display the Select Time screen.  

 

The current time is defaulted, to the nearest 5-minute increment. We want the alarm to go 

ASAP, so we will leave the time as is. When you are setting a time further away, 

remember to get the AM/PM setting correct.  

5. Click OK to select the defaulted time. 

6. Now, enter the following text in the Alarm Text field:  

 

So far, you have survived this training. Keep up the good work. 

7. Click the OK button to close and save your alarm. 

 

The alarm engine in People-Trak checks the status of alarms every so many minutes. It is 

not meant to be precise and you should not set crucial appointments or your oven by the 

system. Each user can set the frequency with which alarms are checked. You can check 

and set this interval using the User Setup option. Try that now, while we are waiting for 

the alarm to go off. 

8. On the Setup menu, select User Setup. Click the Preferences tab and find the Alarm 

Frequency field.  

 

This is how often the alarms are checked. This value is normally set to 5 so that alarms 

are checked every five minutes.  

9. In the Alarm Frequency field, click the popup button to display the other alarm 

frequencies.  

 

If you just do not want alarms popping up all the time, either do not set them, do not let 

other users set them for your user name, or increase your interval to 60 minutes. 
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The 1 minute option should only be used if absolutely necessary as it will slow system 

processing time. We are going to select that option because time is of the essence. 

10. Select 1 minute. Close the User Setup screen, saving your change.  

11. If the Alarm screen has popped up, close it. If that screen has not yet popped up, open 

your Inbox and you can find the alarm there. Open the alarm from your Inbox and it will 

act just as if it popped up on the timer. Close the Alarm screen. Note that the alarm status 

is now Read. Close the Inbox.  

 

If an alarm is set for a future date, it will not display in the recipient’s Inbox until that 

date. As we just demonstrated, the alarm can be executed manually by opening it in the 

Inbox or the user can wait until the timer pops the alarm for him. 

12. This concludes this tutorial and lesson.
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This lesson covers how to create a schedule trigger and define the conditions under which the 

trigger will be executed. It also covers how to use actions such as Set Alarm, Send Message, 

and Assign Task. 

Tutorials 
Define Schedule Trigger Conditions: shows how to create a schedule trigger and define the 

conditions under which it will be executed. 

Assign Document Tasks: demonstrates how to assign document tasks to the schedule 

trigger. Also shows how to use a cluster report to simplify running multiple documents. 

Set an Alarm and Send a Message: shows how to use the Set Alarm and Send Message 

actions. 

Assign and Execute Multiple Tasks demonstrates how to assign multiple tasks to the 

schedule trigger as well as execute them from the Inbox. 
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Tutorial 2.1 – Define Schedule Trigger Conditions 

Schedule triggers are similar to alert triggers but are based on a different type of condition. 

1. On the Tools menu, select Schedule Triggers. 

 

The Schedule Triggers screen is displayed and is very similar to the Alert Triggers screen 

you just learned about. We can skip redundant details and get started. 

2. On the File menu, select New Schedule Trigger or on the Tool Bar, click the New 

Schedule Trigger button to create a new schedule trigger.  

3. Change the name to My Scheduled Reports. 

4. Set the Category field to Personal. 

 

The next field is the Active check box. This field works just like it does with alert 

triggers. If the check box is selected, the schedule trigger is active and will be checked 

each day. If the check box is not selected, the schedule trigger is inactive and will not be 

checked each day. The Active check box is automatically selected when a new schedule 

is created.  

5. Leave the Active check box selected. 

 

We will learn about the Last Execution and Next Execution date fields in a bit. 

6. Click the Conditions tab. 

 

Now we’ll set a condition for the schedule trigger. Unlike alert triggers, which are based 

on a date within an employee (or applicant, trainee, etc.) record, schedule triggers are 

based on specified points in time. When that time is met, the trigger actions will be 

executed. For example, you might wish to schedule a series of reports to be run each 

month. Or you may wish to send an email to the benefits carrier with an attached report 

every month.  

 

The condition is made up of three fields. The first two fields set the frequency and the 

start date for the schedule trigger. The third field, which is not always visible, indicates a 

special value based on the frequency selected. For example, if you select a monthly 

frequency, the third field will reflect the day of the month on which the trigger is to be 

executed. For a weekly frequency, the third field will indicate the day of the week on 

which the trigger is to be executed.  

7. Set the Frequency to Monthly. Leave the Start Date set to the default of today’s date.  

 

Note that the third field labeled Day of Month is displayed and that the value is set to the 

day of the month associated with today. The actions associated with this schedule trigger 

will be executed each month on that day of the month. Before we move on to the actions, 

let’s take a look at some other frequencies. 

 

Note: If you set the Frequency to Monthly and the Day of Month is 28 or higher, People-

Trak assumes that you want to run the report at the end of every month. This is required 

in the event that you have a Start Date of March 31 because not all months have 31 days. 

8. Set the Frequency to Weekly.  
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The date is already set, so the third field labeled Day of Week is displayed. The value is 

set to whatever day of the week is associated with today. 

9. Set the Frequency to Daily.  

 

There is no third field. This schedule will be executed every day. 

10. Set the Frequency to One Time Only.  

 

Again, there is no third field. This schedule will be executed just one time on the date 

specified, and then its Active flag will be cleared so it will not be executed again. 

11. Set the Frequency to Every So Many Days.  

 

This time the third field is labeled Number of Days and the field is editable. You can 

define the number of days by putting in a value. The first period will start on the start 

date and every “so many” days, the trigger will be executed. 

 

We are going to use the monthly frequency for our demonstration. 

12. Set the Frequency to Monthly and leave the Start Date as today’s date. 

13. Continue with the next tutorial. 
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Tutorial 2.2 – Assign Document Tasks 

You have set the schedule conditions, so now it is time to specify the actions. 

1. On the Actions tab, click the popup button to display a list of the available actions.  

 

The list of actions is the same list available for alert triggers. That is because schedule 

triggers are executed very much like alert triggers and do not assume that data entry is in 

process.  

 

The most commonly scheduled task is the running of a report.  

2. Select an Assign Task action.  

 

We will use this action to place a “ready to run” report in your Inbox. 

3. Open the details for this action.  

4. Since this is your schedule, put your User ID (DEMO) in the User ID field.    

 

The Task Date is the date the task will be assigned and is supported by the Select Date 

and Date Variable popups. If the trigger to which this task is attached has a frequency of 

more than once, this task needs to be assigned more than once and date variables allow 

you to not have to update this date every time the task needs to be assigned. For example, 

if you always want the task to be assigned the same day that the trigger is executed, you 

would use the TODAY date variable for this date. There are times when you might want 

to use other date variables if you don’t want the task assigned on the same day the trigger 

is executed. Using date variables gives you that flexibility. 

5. In the Task Date field, use the Select Date Variable button to select TODAY. 

6. Since we are going to schedule a report, set the Task Type to Document. Finally, in the 

Task Name field, click the popup button  

7. Stay in the currently highlighted Adhoc Reports type. Select the General category in the 

list of categories in the lower left, and then select the Alphabetic Employee List 

document in the list on the right. Click OK to return that document to the Task Name 

field. 

We have now scheduled a report. 

8. Close the Assign Task screen, saving your changes. Close the Schedule Triggers screen.  

 

Now we’ll test the trigger. 

 

Schedule triggers are just like alert triggers and are executed when logging into People-

Trak, switching between modules and executing NightRun.  

9. Switch the current module to Safety Management and then switch it back to Personnel 

Management. 
 

Did anything happen? Are you sure? Nothing visible happened because the Assign Task 

action, like all alert and schedule trigger actions, does not have user visible components. 

(The only reason you saw the emails in the last lesson is due to the email simulation 

feature. Had the emails actually been sent, you would have seen nothing happen.) 
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10. Open your Inbox. Now you can see what happened. A Document task has been added to 

your Inbox. Find the task and double-click on it. The employee list is run and displayed 

in the Document Viewer. Close the Document Viewer, and you are returned to the 

Inbox. Note that the task Status is now Completed.  

11. Click the Delete button to delete this item from the Inbox. Close the Inbox. 

12. On the Tools menu, select Schedule Triggers. Select the My Scheduled Reports 

trigger. 

 

The Last Execution date has been updated by the system to today’s date. The Next 

Execution date has been updated by the system to be one month from today based on the 

Frequency of Monthly that we assigned to this trigger. This trigger will not be executed 

again until that date.  

 

If you ever need to change the conditions under which this trigger is executed, you will 

also need to clear this Next Execution date in order for the trigger to be executed using 

the new conditions. In our case, we want to add another action and execute the trigger 

again, so we need to clear the Next Execution date so we can execute the trigger again 

today. 

13. Clear the Next Execution date so that the trigger will be executed again. 

14. On the Actions tab, add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Document 

Task Name  Birthday List by Date  (in the General category) 

15. Close the Assign Task screen, saving your changes. Close the Schedule Triggers screen. 

16. On the Setup menu, select User Setup. Click the Preferences tab. To make the reports in 

your Inbox more obvious (and to prevent you from ignoring your Inbox); select the 

Inbox on Login check box. Close the User Setup screen, saving your changes. 

17. On the File menu, select Logoff to logout of People-Trak without actually leaving the 

program. Then log back in. 

 

Without any visible indicator, the schedule trigger was executed and two tasks were 

added to your Inbox. Because we displayed the Inbox on login, the Inbox will be 

displayed just as soon as the tasks are complete. (All of this will happen more or less 

instantly.) 

18. Double-click on the first Document task. The report is run and displayed. Close the 

Document Viewer. Double-click on the second Document task. Again, the report is run 

and displayed. Close the Document Viewer.  

19. Click the Delete button to delete each of these items from the Inbox. Close the Inbox. 

 

This is pretty cool, but there were just two simple reports that ran in seconds. What if 

there were 30 monthly reports and some took longer to run? In this case, the schedule 

trigger would be wonderful for scheduling and reminding, but falls short on convenience 

and timesaving. What can be done? We can create a cluster report. Let’s do that now. 
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20. On the Documents menu, select Cluster Reports. Create a new cluster report and set the 

Cluster Name to Monthly Cluster Report. Set the Explorer Category to General, 

overriding the table if necessary and set the Category to Personal. On the Documents 

tab, add the two reports we listed individually in our trigger. These are both in the 

General category:  

 

Alphabetic Employee List 

Birthday List by Date 

21. Close the Cluster Reports screen, saving your changes. Close the Explorer. 

22. Return to the Schedule Triggers process and select the My Scheduled Reports trigger 

on which we have been working. On the Actions tab, delete the second Assign Task 

action. Then open the details for the remaining Assign Task action and change the 

document to the Monthly Cluster Report we just created, which is in the General 

category of Cluster Reports. 

23. Close the Assign Task screen, saving your changes. On the Details tab, once again clear 

the Next Execution field so we can test our trigger. Close the Schedule Triggers screen, 

saving your changes. 

24. Logout of People-Trak and then log back in. When the Inbox is displayed, there should 

be just one Document task displayed this time, and it is a cluster report. Run the report.  

 

In the Document Viewer, you can see that this cluster report contains the same two 

reports we ran last time. This was much faster and more convenient. 

25. Close the Document Viewer. Delete this item from the Inbox and then close the Inbox. 

26. Continue with the next tutorial. 
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Tutorial 2.3 – Set an Alarm and Send a Message 

There are two more actions that both alert triggers and schedule triggers can use. We will 

show how to use them in this tutorial. 

1. On the Tools menu, select Schedule Triggers. Select the My Scheduled Reports 

trigger.  

2. On the Actions tab, add a Set Alarm action and go into the details for that action. 

 

The Set Alarm screen is displayed. Setting an alarm from a trigger is just like using the 

Set Alarm tool, which you learned about in the previous lesson. 

3. In the User ID field, enter DEMO. 

 

The Alarm Date is used for an alarm just like you learned the Task Date is used for a 

task. We want the alarm to be set on the same day as the trigger is executed, so we will 

use the TODAY date variable. 

4. In the Alarm Date field, use the Select Date Variable button to select TODAY. 

 

The Alarm Time field is the time of the alarm and is supported by the Select Time popup. 

If you leave this field blank and the Alarm Date field is TODAY, the alarm will go off as 

soon as the trigger is executed. 

5. Leave the Alarm Time blank so this alarm will go off as soon as the trigger is executed. 

6. In the Alarm Text field, enter the following:  

 

There are reports in your Inbox. All you need to do is open the Documents task and 

the reports will be run.  

7. Close the Set Alarm screen, saving your changes. 

8. Add a Send Message action and go into the details for that action. 

 

The Send Message screen is displayed. This action simply sends a message to the 

specified user’s Inbox.  

9. In the User ID field, enter DEMO. 

10. In the Message Text field, enter the following:  

 

Please call me after you review the monthly reports in your Inbox. 

11. Close the Send Message screen, saving your changes. 

12. Clear the Next Execution date so the trigger will be executed again today. 

13. Close the Schedule Triggers screen, saving your changes. 

 

Let’s turn off having your Inbox shown on login.  

14. On the Setup menu, select User Setup. Click the Preferences tab. Clear the Inbox on 

Login check box. Close the User Setup screen, saving your changes. 
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15. Log off and back in. 

 

The alarm may not go off right away. Remember that the alarm engine in People-Trak 

checks the status of alarms every so many minutes, based on the Alarm Frequency setting 

for that user. To save some time, let’s manually kick off your alarm. Just imagine that 

this alarm popped up while you were doing other work in People-Trak. 

16. Open the Inbox and then open the Alarm task.  

 

This alarm would tell you that you have reports to look at.  

17. Close the Alarm screen. 

18. Open the Document task. 

 

The cluster report is run. 

19. Close the Document Viewer. 

20. Open the Message item, read it and then close it. 

 

Simple as that. You can have as many actions as you need on triggers. 

21. Close your Inbox. 

22. This concludes this tutorial and lesson 
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Tutorial 2.4 – Assign Multiple Tasks 

This tutorial will demonstrate the awesome capability that the Assign Task feature provides 

for executing a series of tasks without having to go back and forth between the Inbox and 

Organizer desktop. 

 

Our goal is to create a schedule trigger that assigns a set of tasks to the HR Generalist on a 

monthly basis. We will start by making some necessary changes to our trigger that already 

exists. 

1. On the Tools menu, select Schedule Triggers. Select the My Scheduled Reports 

trigger. 

2. Change the name to Monthly HR Tasks 

3. Clear the Next Execution date so that the trigger will be executed again. 

4. On the Actions tab, delete the Send Message and Set Alarm actions, as we won’t need 

them anymore. 

Let the tasking begin! 

5. On the Actions tab, add an Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Create 

Task Name  Standard Employee  

6. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Edit 

Task Name  Standard Employee  

7. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Administration 

Task Name  Adhoc Reports 

8. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Link 

Task Name  www.people-trak.com 

9. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 
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Task Type  Document 

Task Name  Alphabetic Employee List 

10. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Activity 

Task Name  Random Employee Selector 

11. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Processing 

Task Name  Other Compensation Batch 

12. Add another Assign Task action. Set the details as follows: 

 

User ID  your user ID 

Task Date  TODAY  (select using the Select Date Variable popup) 

Task Type  Table 

Task Name  City 

13. Close the Assign Task screen, saving your changes. Close the Schedule Triggers screen. 

14. Switch the current module to Safety Management and then switch it back to Personnel 

Management. 

15. Go ahead and open our full Inbox.  

16. At the top of the list of items is a Create task using the Standard Employee workflow. 

Double-click on it.  

The Create Employee screen is displayed with the Employee Source field set to Scratch.  

17.  Select Close and return to the Inbox. 

18. Double-click on the Edit task.  

The Lookup Employee screen is displayed for us to select a record to edit.  

19. Select Close and return to the Inbox. 

20. Launch and close the Adhoc Reports administration task, the People-Trak link task, the 

Alphabetic Employee List document task, the Other Compensation Batch processing 

task, and the City table task. 

That’s all there is to it! Scheduling and assigning tasks just made the start of the month 

much more efficient for our HR user. 

21. Click the Delete button to delete each of these items and close the Inbox. 

22. Exit People-Trak. 

23. This concludes this tutorial and lesson. 
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Notes 
 


